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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be
construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, Commercial Computer Software,
Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notice

© 2016 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle and Java are registered trademarks of Oracle and/or its affiliates.

UNIX® is a registered trademark of The Open Group.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

For a complete list of open source and third party acknowledgements, visit the HP Software Support Online web site and search for the product manual called HP Service
Manager Open Source and Third Party License Agreements.

Documentation Updates

The title page of this document contains the following identifying information:

« Software Version number, which indicates the software version.
« Document Release Date, which changes each time the document is updated.
« Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to: https://softwaresupport.hp.com/.

This site requires that you register for an HP Passport and to sign in. To register for an HP Passport 1D, click Register on the HP Support site or click Create an Account on the
HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support

Visit the HP Software Support site at: https://softwaresupport.hp.com.
This website provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your
business. As a valued support customer, you can benefit by using the support website to:

« Search for knowledge documents of interest

« Submit and track support cases and enhancement requests
« Download software patches

« Manage support contracts

« Look up HP support contacts

« Review information about available services

« Enter into discussions with other software customers

« Research and register for software training

Most of the support areas require that you register as an HP Passport user and to sign in. Many also require a support contract. To register for an HP Passport ID, click
Register on the HP Support site or click Create an Account on the HP Passport login page.

To find more information about access levels, go to: https://softwaresupport.hp.com/web/softwaresupport/access-levels.

HPSW Solutions Catalog accesses the HPSW Integrations and Solutions Catalog portal website. This site enables you to explore HP Product Solutions to meet your business
needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this website is
https://softwaresupport.hp.com/group/softwaresupport/search-result/-/facetsearch/document/KM01702710.
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What's new in this release

This section describes the important changes in this release.

Tip: The following knowledge base article contains links to all the previous 9.4x release notes and
patches. This article enables you to always find the most up-to-date release notes and the latest
9.4x patches.

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
[facetsearch/document/KM01384297

Solr embedded Tomcat is upgraded to version 8

The version of Tomcat that is embedded in the SOLR search engine is upgraded to 8.0.32. For more
information, see "Knowledge Management (KM) Search Engine and Import Utility installation" on
page 68.

Supported items

HP Service Manager 9.41 Patch 5 includes the following certification changes.

Added support

Web tier

« lIS8.0andIIS 8.5
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Enhancements

Enhancements

This release includes the following enhancements. The following tables include all enhancements that
were implemented after the release of Service Manager 9.41P4.

Knowledge management
CR Problem Solution
QCCR1E133021 Upgrade SOLR's SOLR's embedded Tomcat
embedded Tomcat to version is upgraded to version
8.0.x version. 8.0.32

Web client

CR Problem Solution

QCCR1ES8989 The Service Manager web tier does not The Service Manager web tier now
support IIS 8.0 and IIS 8.5. supports IS 8.0 and IIS 8.5.
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Fixed defects

This release fixes the following defects. The following tables include all fixes that were implemented
after the release of Service Manager 9.41P4.

Documentation

CR Problem Solution

QCCR1E137117 = All 9.4x Release Notes (except 9.40 P2 and 9.40 P3) in correctly state The

that QCCRT1E103456_SM940_SM932.unl can be loaded into Service affected
Manager version 9.30 or later. This .unl file can be unloaded only into documents
version 9.32 and later. are
updated.

CR Problem Solution

QCCR1E132890 When you unsubscribe from a subscription, the The previously added
previously added comment is displayed in the comment is no longer
comment area on the unsubscribe confirmation displayed in the comment
window. area now.

QCCR1E135240 SRC Item Option is filled and displayed on SM server = SRC item Option is not filled

when the Visible condition is false. or displayed on SM server
when the Visible condition is
false.
QCCR1E136291 @ Surveys can create interactions for inactive Surveys cannot create
categories (such as complaint and compliment) in interactions for inactive
SRC. categories in SRC.

QCCR1E136433 SRCitem Options fail to pass date validation when  Now, SRC Item Options work

using tod(). properly when using tod().
QCCRTE136570 | The Service button on popup window is missing The Service button on popup
after you use Service Assistant in SRC. window is now displayed
correctly.

HP Service Manager (9.41) Page 7 of 75


https://softwaresupport.hpe.com/group/softwaresupport/search-result/-/facetsearch/document/LID/QCCR1E137117
https://softwaresupport.hpe.com/group/softwaresupport/search-result/-/facetsearch/document/LID/QCCR1E132890
https://softwaresupport.hpe.com/group/softwaresupport/search-result/-/facetsearch/document/LID/QCCR1E135240
https://softwaresupport.hpe.com/group/softwaresupport/search-result/-/facetsearch/document/LID/QCCR1E136291
https://softwaresupport.hpe.com/group/softwaresupport/search-result/-/facetsearch/document/LID/QCCR1E136433
https://softwaresupport.hpe.com/group/softwaresupport/search-result/-/facetsearch/document/LID/QCCR1E136570

Service Manager 9.41 Patch 5 Release Notes

Fixed defects

CR

QCCRTE136690

Server

CR

QCCRTE73672

QCCR1E96440

QCCRTE134641

QCCRTE134651

QCCR1E134743

Problem

Item options are invisible in SRC when the option
visible condition is set to true.

Problem

When you use the writeFile() JavaScript to output an
attachment, Japanese characters in file names are
output as garbage characters.

The session crashes and a Signal 11 error is
generated when you perform an IR search on corrupt
IR data.

When an Assignment Group of Incidents is empty, the
text "NULL" in the Grouping View is not localized.

After you upgrade Service Manager, the sequential
number file issues incorrect SQL to the back-end
Oracle database in SQL. Additionally, you receive the
following error messages:

RTE E Error: SQL code=904
message=0RA-00904: "NUMBER": invalid
identifier RTE E API=0CIStmtExecute
[in sgociOpen], Statement=SELECT
"NUMBER", "SYSMODCOUNT" FROM NUMBERML
WHERE "NAME"='cm3r' FOR UPDATE

If an operator has access only to certain incidents
(scsecuritygroups is enabled) and the logical name

HP Service Manager (9.41)

Solution

Now, item options are visible
in SRC when the option visible
condition is set to true.

Solution

Now when you use the
writeFile() JavaScript to
output an attachment, non-
ASClI characters (such as
Japanese and Chinese
characters) in a file name
are output using UTF16
encoding.

You can now perform an IR
search on corrupt IR data as
expected.

When an Assignment Group
of Incidents is empty, the
text in Grouping View is
localized.

Now the hard-coded
"NUMBER" column in the
SQL statement is replaced
with the real SQL column
name in the dbdict of the
file "number".

Note: After you upgrade
from SC6, you must map
the "number" field in the
dbdict of the "number" file
to the real SQL column (that
is, "NUMBERPRGN").

Now the sorting works as
expected, and the
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Fixed defects

CR

QCCR1E134760

QCCRTE134779

QCCR1E135364

QCCRTE136119

QCCR1E136244

Problem

solution is enabled, the following error message is

displayed when them operator sorts a queue or view

by service.

4580 (
-Memory :
(5252652)
4580 ( 9780)
Base login Response:
1.061 Js:
0.530(03585)

9780)
S5(4096440)

LDAP:

application:login,cleanup 4580 (
06/27/2016 09:50:42 RTE E Error:
code=1791 message=0RA-01791:
SELECTed expression 4580 (

06/27/2016 09:50:33 RTE I
0(1156212)
- MALLOC's Total (606052)

06/27/2016 09:50:33 RTE I

MAX

0.156 Log:0.000 Database:

1.747 -- RAD:
0.000 (CPU 1.434)
9780)
SQL

not a

9780)

06/27/2016 09:50:42 RTE E

API=0CIStmtExecute
sqociSelectSome],

[in
Statement=SELECT

DISTINCT ml."AFFECTED

ITEM",ml."NUMBER"

FROM PROBSUMMARYM1

ml JOIN PROBSUMMARYAZ2 a2 ON

(ml."NUMBER" = a2."NUMBER")

LEFT

OUTER JOIN DEVICE2M1 device(O ON
deviceO."LOGICAL NAME"=ml."AFFECTED

ITEM" WHERE
ml."ASSIGNMENT" IN (
a2."TXBUSINESSTHREAD

((ml."FLAG" =
1Y)

:Y and
and

Servlets crash at random, regardless of whether or
not they are on a server that contains a load

balancer.

When some views that use tod() in the criteria and
Group By are displayed, the following error occurs:

SQL code=932 message=0RA-00932: inconsistent
datatypes: expected DATE got NUMBER

There are duplicate lines in Problem descriptions.

An incremental index of hot topics does not finish

successfully.

Terminated sessions are not cleaned up until all

HP Service Manager (9.41)

Solution

generated SQL statement is
as follows:

SELECT t1Tm1."NUMBER",
t2m1."DISPLAY_NAME"
FROM PROBSUMMARYM1
t1m1JOIN
PROBSUMMARYA3 t1a3 ON
tTm1."NUMBER" =
t1a3."NUMBER" LEFT OUTER
JOIN DEVICE2M1 t2m1 ON (
t1m1."LOGICAL_
NAME"=t2m1."LOGICAL_
NAME" ) WHERE
t1a3."TXBUSINESSTHREADS"
IN (:Y) ORDER BY
t2m1."DISPLAY_NAME"
DESC, tTm1."NUMBER"

The crash no longer occurs.

Now, sub-expressions such
as "tod() +/- TIME" in
queries are computed
before the SQL statement is
regenerated, and this issue
does not occur.

Now the extra empty lines
are not inserted.

An incremental index of hot
topics finishes successfully.

This issue is caused by a
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Fixed defects

CR

QCCRTE136601

QCCRT1E136718

QCCR1E137012

Problem

Solution

available connections are used and users can no database lock that is not

longer log in to Service Manager.

released when an exception
occurs. This lock will now
always be released.

An error occurs when you choose "Update from No error occurs when you
customer - Interaction” in the To Do Queue tab. choose "Update from

customer - Interaction" in
the To Do Queue tab.

When you try to unload a device or pcsoftware table ~ Now when you try to unload
the unload process never finishes. a device or pcsoftware

table, the unload process
finishes as expected.

A Signal 11 error occurs when you search for a device = No Signal 11 error occurs
file. This issue occurs because an SQLFile operation when you search for a
(sgmkFindField()) is called on a MergeFile (device). device file.

Web client

CR

QCCRTE57750

QCCR1E97896

QCCRT1E112184

Problem

If the DVD visible condition is
set in the web client, and if
the condition defaults to
"invisible", you cannot see the
HTML viewer container,
whether the condition is true
or false.

In the ESS client, when the
user clicks the Fill button for a
field, the popup search
window contains such a large
blank area that the user has
to scroll down to the bottom
to click a button.

The Phase field content and
the workflow title are not
localized on a localized

HP Service Manager (9.41)

Solution

If the DVD visible condition is set in the web client,
and if the condition defaults to "invisible", you can
see the HTML viewer container as expected.

In the ESS client, no scrollbar is displayed in the
popup search window, and the window no longer
contains large blank space.

The content is now localized. The workflow title is
still not localized as it is a by-design limitation.
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Fixed defects

CR

QCCR1E123661

QCCR1E131253

QCCR1E133642

QCCRT1E134028

QCCR1E134070

QCCR1E134216

QCCRT1E134565

Problem
environment.

The "Attachment" notebook
name is not displayed on the
Print Detail page when

Process Designer is enabled.

The attachments frame
overlaps in the print page of
an incident details form.

The web client gets stuck
when you are copying content
from an email to the
Description field of an
Interaction record.

If a script called from the
"login.DEFAULT" format
controlis configured, the
"Dashboard" Home Page
screen is not displayed
properly after clicking the
Skip button.

There are performance issues
when accessing the Time
Period module using Chrome.

When ?telephonyuser=1is
appended to the web client
URL, the Java applet for
telephony masks part of the
system navigator.

When the user uses the
magnifying tool (F2) in a text
area field on the web client
and clicks Save, the text
entered in the magnifying tool
is not displayed immediately
in the text area field. The user
needs to click again on the
text area field for it to refresh

HP Service Manager (9.41)

Solution

The "Attachment" notebook name is now displayed
as expected on the Print Detail page when Process
Designer is enabled.

The attachments frame does not overlap in the
print page.

You can successfully copy email content to the
Description field of an Interaction record without
any performance problems.

The "Dashboard" Home Page screen is displayed
properly after clicking the Skip button.

The rendering time is now close to previous
versions and the performance issues are gone.

The Java applet no longer masks the system
navigator.

When the user uses the magnifying tool (F2) in a
text area field on the web client and clicks Save,
the text entered in the magnifying tool is displayed
immediately in the text area field.
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Fixed defects

CR Problem

and display the information.
An example text area field is
the Description field in the
Interaction form.

QCCR1E134619 Overlapping text is displayed
when printing Quotes or
Interactions that use the

HTML Viewer.

QCCR1E135254 When you apply a Fill Search
Format to a Comfill field, and
then search for a non-
existent record, the system
produces an error message.
However, the error message
is displayed below the search

window.

HP Service Manager (9.41)

Solution

Text overlap does not occur when printing Quotes
or Interactions that use the HTML Viewer.Note: The
HTML viewer may not support Print with IDOL. To
support Print with IDOL, perform the following
steps:

1.Log in to Service Manager as a system
administrator.

2. Type db in the command line, and press Enter.

3. Enter idolwebresources in the Table field, and
click Search.

4. Enter IDOL_TOPICMAP_TEMPLATE in the Name
field, and click Search.

5.In the "Raw source code" section, insert the
following line immediately before the <div
id="chart"> line:

<div
style="position:absolute;width:100%;height:100%">

6. Insert the following tag immediately before the
</body> tag:

</div>
7. Save your changes.

8.Log in to the web client again for the changes to
take effect.

The error message is shown on top of the search
window.
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Fixed defects

CR

QCCRTE135560

QCCRTE136128

QCCR1E136206

QCCR1E136202

QCCR1E136526

QCCRTE136659

Problem

A configured Data Changed
Event is not triggered when
you change the Comfill data
by clicking the popup item.

When you view a template in
the web client on Internet
Explorer and click the "Show
Next 50" or "Show All" option,
the page hangs and keeps
trying to load the fields of the
template.

The first Tab of a Notebook is
not reset to be active after an
Interaction record is closed
and the page returns to a
blank Interaction.

The focus is lost after
entering a value in a comfill
control with an array.

When you order from the
Catalog in the Service
Manager web client and add
an attachment to the order,
before you click Submit, the
attachment is not inserted
into the Interaction that is
opened. Once this issue
occurs, no further
attachments can be added to
Interactions from Orders, until
the application server (i.e.
Apache Tomcat) is recycled.
However, after 7 to 12 Orders
have been submitted with
attachments, the issue occurs
again.

The HTML Editor for the
description field in Incident

HP Service Manager (9.41)

Solution

The configured Data Changed Event is now
triggered when you change the Comfill data by
clicking the popup item.

The web client displays all the template fields
successfully you view a template in Internet
Explorer and click the "Show Next 50" or "Show All"
option.

The first Tab of a Notebook is reset to be active
after an Interaction record is closed and the page
returns to a blank Interaction.

The focus is not lost after entering a value ina

comfill control with an array.

This issue no longer occurs

The HTML Editor is correctly rendered now.
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Fixed defects

CR Problem Solution

forms is not correctly
rendered after you view the
related records.

QCCR1E136687 | The web client hangs when The web client does not hang when you try to click
you try to click "Show next 50" | "Show next 50" button in Advanced Filter
button in Advanced Filter Conditions that has more than 20 lines filter
Conditions that has more than conditions definitions using Internet Explorer.

20 lines filter conditions
definitions using Internet
Explorer.

QCCR1E136933 QCCR1E132904_SM941P3_ The unload is removed from the current release.

SM941.unl was incorrectly
packaged into the SM941P4
release.

QCCR1E136982 Data Changed events that are  Data Changed events that are configured for
configured for Comfills are Comfills are triggered when the focus is not on the

not triggered when the focus = Comfill.
is not on the Comfill.

Windows client

CR Problem

QCCR1E136172 @ The time and calendar drop-down wizard does not work as
expected on some date fields. This issue occurs mainly on
tables within subforms, when the table has a number of date
columns. This issue prevents you from selecting dates from
the calendar widget, as the widget does not appear.

QCCRTE136341 After you upgrade from Service Manager 9.31 to 9.41, the
icons and descriptions are on the startup menu, but the
labels are missing.

QCCRTE135567 ' You cannot disable administration mode when you install the
Service Manager Windows client.

HP Service Manager (9.41)

Solution

The time and
calendar drop-down
wizard works as
expected.

Startup menu labels
are displayed as
excepted.

An option is added
to enable you to
disable
administration
mode for the
Windows client
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Fixed defects

CR Problem Solution

installation.
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Known issues, limitations, and workarounds

Known issues, limitations, and workarounds

This release has the following known issues and limitations. This is a cumulative list of known issues and

limitations in Service Manager, including those that are already documented in previous release notes

(Service Manager 9.40 and patches, and Service Manager 9.41 and patches).

Known issues

Global ID

QCCR1E132020

QCCR1E130573

QCCR1E132194

Issue

When FIPS mode in enabled (fipsmode:2
is specified in the sm.ini file), Service
Manager initialization might be slow in
Linux/Unix environments. This issue is
caused by a lack of entropy
(randomness) available on the system
used for random number generation
and can commonly occur on systems
that are not receiving much direct user
input, such as virtual machines.

When you use Java 8 and the Jsafe 6.2,
the TLS connection cannot choose the
ECDHE ciphers.

The ssl configuration topic of the

Smart Analytics document is missing
information to configure level2proxy
and image server. The information to

HP Service Manager (9.41)

Workaround

You can direct the JVM to use
/dev/urandom with the following
directive:

Add the following line to the Server's
sm.ini file:

-Djava.security.egd=Ffile:/dev/urandom

Alternatively, you can add the following
line to the jre/lib/security/java.security
file:

securerandom.source=file:/dev/urandom

For additional information, see the
following important third-party
information:

http://bugs.java.com/view_bug.do?bug_
id=6521844

http://www.2uo.de/myths-about-
urandom/

Do not set the ECHDE cipher in the cipher
parameter in the sm.ini file.

See the corrected configuration topic at:

How to configure TSL/SSL for two-way
authentication between Service Manager
and Smart Analytics
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Global ID

QCCR1E130718

QCCR1E128546

QCCR1E128412

QCCR1E124820

QCCR1E127867

QCCR1E127873

QCCR1E127871

QCCR1E127858

Issue

configure the CFS server is also
incorrect.

When you rotate the screen of an i0S9-
based device to landscape and then
back to portrait, the Mobility client
page is incorrectly displayed.

On a virtual machine with Interl(R) Core
(TM)2 Duo CPU T7700 @2.40 Ghz, 2.59
GHz(4Processors), a memory leak
occurs on the http connector server.

On Unix platforms, the legacy listener
does not work if Service Manager
server uses the Oracle 12c instant
client.

After you add the "Service Display
Name" field to a Change view and
specify the "Service" field as a group-
by field, an error occurs and the view
does not load when you sort the view
by Service Display Name.

The "Chart by" functionality does not
work when there is an outer join field in
the view.

In the Service Manager (SM) Hybrid
mode, calling the SM RESTful API for
UCMDB integration for the first time
will fail.

In the "Chart by" form,
"sm.device.display.name" is displayed
as the value of the "Display Name"
column.

The index status is not updated into
the Knowledge Management

HP Service Manager (9.41)

Workaround

To work around this issue, refresh the
browser.

There is currently no workaround
available.

There is currently no workaround
available.

Add either the “Service” field or the
“Service Display Name” field to both the
view and the list of group-by fields.

Note: The “Service” field is preferred
because this field is populated with CI
Display Name values. There is no
need to add the second level field,
Service Display Name.

Use Service Manager Reports instead.

Make a call to the API after you set up the
SM Hybrid environment.

There is currently no workaround
available.

Drill down into the Knowledge
Maintenance page for the library to
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Global ID

QCCR1E127872

QCCR1E127858

QCCR1E127861

QCCR1E126469

QCCR1E124206

Issue

knowledge base, and thus the library
cannot be searched in the main search
page and the context-aware page.

The IDOL content service does not start
on machines that have 24 CPU cores
configured.

The new library index status is not
updated in the "kmknowledgebase"
table when you click Full Reindex in the
Knowledge Maintentance page.

The logical.name of the Clis displayed
on the "Edit 00 flow" widget for
Emergency Change records in the
"Build and Test" phase.

Chrome 44 refuses to send https
requests to a web server with a self-
signed SSL certificate. Additionally, you
receive the following error message:

Failed to load resource:
net: :ERR_INSECURE_RESPONSE

Since all requests are blocked, the web
server terminates the user session

after a while and the user is logged out.

Service Manager survey does not
support multiple company.

HP Service Manager (9.41)

Workaround

synchronize the index status into the
Knowledge Management knowledge base.

You can apply a workaround if the
following error appears in the
application.log of the content server:

[1] 7@-Error: Error: Attempt to
open [ =.)0] failed. (No such
file or directory). The file open
mode [rb] does not permit
creation of a new file.

In this case, modify the following
parameters in the configuration of the
content server, and then restart the
content server.

[Server] Threads=x [AsyncActions]
Threads=y let x+y<32

Refresh the status in library
configuration.

There is currently no workaround
available.

Use Chrome 43 instead.

There is currently no workaround
available.
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Global ID

QCCR1E124149

QCCR1E124144

QCCR1E124821

QCCR1E122174

QCCR1E124466

QCCR1E125500

QCCR1E126359

QCCR1E119401

QCCR1E121838

QCCR1E122115

QCCR1E125879

Service Manager 9.41 Patch 5 Release Notes

Known issues, limitations, and workarounds

Issue

Record that do not satisfy query
conditions for selected lines are

displayed in the calculation chart
report.

You cannot drill down into the
calculation and duration charts when
the aggregator is set to MIN or MAX.

Auto-complete does not work when the
link line of the associated field has the
"Skip Query Rewriting" option enabled.

SMC does not support RTL.

Error messages displayed in English are
not indexed in localized language
versions.

If you enable the
"preventDuplicatedAttachmentName"
parameter in web.xml and then upload
the same file twice, an error message
is not displayed in the Internet Explorer
and Chrome browsers.

English text in screenshots is not
recognized correctly when your contact
language is Arabic.

If you enable the
"preventDuplicatedAttachmentName"
parameter in web.xmland then upload
the same file twice, an error message
is not displayed in the Internet Explorer
and Chrome browsers.

Labels overlap on Stacked Horizontal
bar charts in Reports.

Values less than 0 are not displayed
correctly in bar or area charts.

The additional Request Overview (PD)

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround

Page 19 of 75



Global ID

QCCR1E122716

QCCR1E127170

QCCRTE123090

QCCR1E123438

QCCR1E124369

QCCR1E124633

QCCR1E126198

QCCR1E126737

QCCR1E126780

QCCR1E126842

QCCR1E126847

QCCR1E126848

QCCR1E126852
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Issue

(Global) dashboard and its reports are
displayed in Classic mode.

You cannot drill down into the index for
fsylib.

You cannot tailor 00 flows.

Special characters cannot be searched
for in IDOL.

An error message with an unclear
meaning is displayed when the OMNI
Group Server is offline.

Some returned results from external
libraries are not highlighted.

When you set all Index Weight values to
“No Index” and then click Save, the
configuration is saved incorrectly.

The Smart Search Configuration tab is
incorrectly named “environment:
knowledge management”.

Links in the file system search results
do not open in Firefox or Chrome.

The pagination count is not correct in
the main search page.

The “Set parent” button in Smart
Search should not be shown for non-
Process Designer-based Incidents.

The reported number of search results
from the catalog library is not correct.

SharePoint pages are indexed into IDOL
incorrectly.

Type ahead cannot use the display
value of a global list in the advanced
filter function in Smart Search.

HP Service Manager (9.41)

Workaround

available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.
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Global ID

QCCR1E126886

QCCR1E126901

QCCR1E126974

QCCR1E126978

QCCR1E127031

QCCR1E127368

QCCR1E127036

QCCR1E124715

QCCR1E124520

QCCR1E125084

QCCR1E126163

QCCR1E125549

QCCR1E127029
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Issue

The Change Service value does not
display the Cl Display Name.

Preconditions should be merged if
there are multiple preconditions for a
file, but the criteria conflict.

The reported number of search results
is incorrect.

You cannot select the ID-title in Smart
Searchin Internet Explorer 10.

No error message is displayed in the
library if the attachment is not indexed
successfully.

If you use fields that are not in the
form in the match criteria of a
predefined filter in Smart Search,
Smart Search does not work.

The filter is saved too slowly when you
click “search within results” in Internet
Explorer 10.

You cannot connect to IDOL with an
IPv6 address.

On a tablet, the back and forward
buttons do not work correctly in IDOL
external webpage details pages.

The number of search results changes
after you click to view the next page.

In the HS environment, locked sessions
cannot be killed from the Show Locks
format (system.status.locks.g).

If there is 127.0.0.1 in the hosts file, the
hostname is displayed as
"localhost.localdomain” in the result of
the command "sm -reportlbstatus”.

The average response time of the

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

Add the fields used in the match criteria
of the predefined filter in context aware
search into the form of the current
working ticket.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
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Global ID Issue Workaround

"src01_02_search" transaction is more available.
than 2sin 9.41, compared to that of
0.8s in the previous release.

QCCR1E125884 The old Knowlege Management search  There is currently no workaround
icon is still displayed. available.

QCCR1E127213 The "Content1" service cannot be There is currently no workaround
started by the "Start Service" function = available.
in the IDOL installer.

QCCR1E121838  Inthe "Stacked Horizontal bar" report, = There is currently no workaround
the value labelis truncated. available.

QCCR1E125879 An additional Request Overview (Global) There is currently no workaround
dashboard and its reports are available.
displayed in the Classic mode.

QCCR1E122716  Users cannot drill down into index for The fsyslib link refers to URLs with the
fsylib links. "file://" protocolin search results.

However, Firefox and Chrome do not open
such links when they are clicked in the
result page or in the pages that are
originated from outside the local
machine. This is a design decision made
by those browsers to improve security.
Internet Explorer supports this
functionality by default.

QCCR1E123433 The display name is not displayed in the = There is currently no workaround
mass update interface. Instead, only available.
the logical name is displayed.

QCCR1E120454 The datadict record cannot be saved There is currently no workaround

when the display name is changed. available.
QCCR1E127326 UCMDB federation is blocked. There is currently no workaround
available.

QCCR1E126189 The detail page is not synchorized with | There is currently no workaround
the tab on BlackBerry. available.

QCCR1E127624 Data unloaded from the SQLSERVER There is currently no workaround
NVARCHAR database cannot be loaded  available.
into the Oracle database.
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Global ID

QCCR1E122190

QCCR1E119964

QCCR1E120414

QCCR1E121852

QCCR1E122160

QCCR1E123135

QCCR1E123311

QCCR1E123536

QCCR1E123716

QCCR1E124360

QCCR1E124423

QCCR1E124820

QCCR1E125032
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Issue

If you set a fuzzy search condition
before, the comfill box that has the
reference table setting on displays an
empty list.

When a new record is added in dbdict,
the alias of type is not removed and
the alias for display.name is not
created.

Logical name, instead of display name,
is displayed.

The Fill button does not work if the
values of the "diaplay list" and "value
list" are set in Windows client.

The comfill control of the Clin the "Add
Filter Criteria" wizard does not work.

The Cl Display Name is not displayed on
the "Asset Allocation" form.

An "No Record Found" error is displayed
when characters are deleted from the
end of the value filled by the auto
complete functionality.

The logical.name of the Clis displayed
for the "Create Template from Record"
interface of anincident record.

The order is not correct for Cl Name in
the pivot table.

A tab cannot be closed in the dialog
mode.

Reference cannot be set on the
member of an array of a structure.

The view is broken if you sort a field
that has been a group field.

The style of the popup window is lost
when the session is refreshed.

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

Page 23 of 75



Service Manager 9.41 Patch 5 Release Notes

Known issues, limitations, and workarounds

Global ID

QCCR1E125204

QCCR1E126003

QCCR1E126006

QCCR1E127712

QCCR1E121670

QCCR1E127303

QCCR1E127732

QCCR1E127744

QCCR1E127953

QCCR1E128218

Issue

When the Affected Clin the cross table
is exported as a list, the logical name is
displayed.

No validation is done when you input an
invalid Clin a service level target.

The logical name of a Clis displayed in
the "Additional Properties" tabin a
Request task.

An "invalid CI" error message is
displayed when you select the Cl
through the auto complete
functionality.

The value of the comfill control is not
restored if it is an array list in the
change record.

Chinese characters sent from Lync are
displayed as "????" in Service Manager
Collaboration.

The page is hung after you fill the
incident subcategory in Chrome
(version 44) on Android.

A few strings that are displayed in the
following user interface elements are
not translated:

o Smart Analytics Assistant
configuration form and Time
Duration Checkpoint form in the
upgrade environment

« Upgrade Utility dialog boxes

The string "has been acknowledged" in
the To-do Alert popup message is not
translated.

When you are adding/modifying Cl
relationships, the following

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

Refresh the page in this case, and the list
will be displayed. You can then select an
item and save the record successfully.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.
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Global ID

QCCR1E127567

QCCR1E126631

QCCR1E126641

QCCR1E127857

QCCR1E119102

Issue

Relationship Type values are available
for selection: Accesses, Aggregation,
ClientServer, Composition, and so on,
(which are correct values). However,
when you are viewing Cl relationships in
the Cl detail form, you can select only
the following Relationship Type values
as a filter: All, Logical, and Physical
(which are no longer used in Service
Manager 9.41).

The incident category "request for
change" is not localized in the Service
Manager Hybrid mode.

When you select a value for a task
category in the task planner two times,
only one value is available the second
time.

Related record information for Phase,
Status, and Title in the Interaction
details page is not displayed until you
exit the related Incident session.

An error that indicates the query field
"pd.enabled" in "upginfo" is not defined
in "dbdict" is generated when
smupgrade is invoked.

Internet Explorer 10 or 11 cannot open
some Service Manager pages, such as
calendar and dashboard pages,
because of the pages hanging and not
loading. Additionally, when you access
one of these pages with the F12
developer tools open, an “Access is
denied” message appears on the
console.

This issue may occur when an
automatic Internet Explorer upgrade
has happened in the background,
because both Internet Explorer 10 and

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

To see all list items, clean the combo field
and click the drop-down button again.

There is currently no workaround
available.

Purge data and reload preupg.bin again
after preupg.bin is loaded for the first
time.

Restart your Windows operating system.
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Global ID

QCCR1E115514

QCCR1E115283

QCCR1E113128

QCCR1E114911

QCCR1E116553

QCCR1E118066

QCCR1E117293

Issue

11 have an Install new versions
automatically setting in the About
Internet Explorer dialog.

The Service Manager web tier uses the
local storage functionality of Internet
Explorer. The local storage file is stored
under your user profile folder
(normally, it is

C:\Users\<
username>\Appdata\LocalLow). When
Internet Explorer is upgraded, this
folder is probably protected, and any
attempts to visit the local storage
object will throw a Javascript error.

Auto-complete for the the comfill in
the "Link to Parent Incident" field in the
Incident form does not work correctly.

The color indicator does not work for
the field that retrieves the values from
the DVD.

You cannot select the foreground color
in Color Indicator Setting by using the
keyboard.

Fields in ERDs that are duplicated in
dbdict are not displayed

There is currently no workaround
available.

correctly.

Truncation and overlapping of
elements on the details page of
records occurs when you use the
vertical view.

Truncation and overlapping of
elements on the details page of the
Missing Reference Report occurs when
you use the vertical view.

When you rebuild relationships in

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

Resize the details page to make it wider
or use the horizontal layout.

Resize the details page to make it wider
or use the horizontal layout.

There is currently no workaround
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Global ID

QCCR1E115272

QCCR1E93098

QCCR1E118260

QCCR1E116869

QCCR1E112005

QCCRTET19311

QCCRTE111068

QCCR1E112202

Issue

Relationship Manager, link type
relationships that have a "fixed" status
are removed.

ERDs cannot be recovered when you
open another tab in the same browser.

When you modify a problem record,
and then try to close the record whilst
a backend process modifies the record
at the same time, you are prompted
with a message that asks you to merge
the conflict.

However, after the record is merged,
you cannot close the problem record.

When you search for an incident,
interaction, or change in a heavily-
populated database, the operation
takes more than 20 seconds.

The primary key is lost after you
change the length of a field in a dbdict.

Due to a limitation in Oracle 11g,
records in the patchrelresults and
scmessage tables that have a Primary
Key cannot be unloaded correctly in an
Oracle 11g database.

On Linux, if you run the server
configuration script (<SM
installation
path>/Server/configure)ona
graphic user interface (GUI), an error
occurs.

When you click a Change modelin the
navigation tree in Firefox, a TypeError
occurs.

When a workflow description tooltip
contains too many lines, the
background color is incorrectly

HP Service Manager (9.41)

Workaround

available.

There is currently no workaround
available.

There is currently no workaround
available.

Change the first unique key to the
primary key for the modules that have
this issue.

Manually recreate the primary key.

Change the Primary Key of the
patchrelresults and scmessage tables to
a Unique Key before you perform the
unload.

Run the script on a console by using this
command:

configure -consolemode

Use Internet Explorer or Chrome.

There is currently no workaround
available.
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Global ID

QCCRTET13131

QCCR1E115310

QCCRTE115608

QCCR1E115772

QCCRTE115828

QCCR1E116043

QCCR1E116343

QCCR1E116937

QCCR1E117042

QCCR1E117154

Issue
displayed as white.

When you save a record for which an
additional form is configured, the
display returns to the primary form.

Hotkeys are not supported for menu
items in the workflows page.

You cannot modify the option ID of
workflow-based actions, and an option
ID that duplicates an ID in display
options may be generated.

In Internet Explorer, the workflow
viewer may unexpectedly scroll right or
down if you have a scroll bar and the
browser zooms in.

You cannot expand or collapse the
workflow list folder by using the Space
key. This behavior is therefore not
consistent with accesibility behaviour in
the standard client.

The workflow viewer moves to next
phase incorrectly when an automatic
transition is blocked by an unclosed
task.

The query editor may be launched with
anincorrect query record table name.

Requests that have an open request
task cannot transition to the next
phase, but activities can be saved.

When you approve a record, and that
approval triggers an automatic
transition, open task validation is
bypassed and the automatic transition
occurs even if open tasks exist.

There is no reminder to users that they
must set the table name of a rule set in

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

Manually change the display option ID.

There is currently no workaround
available.

There is currently no workaround
available.

Reload the record.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.
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Global ID

QCCR1E117366

QCCR1E118589

QCCR1E118741

QCCR1E117762

QCCR1E117551

QCCRTE118790

QCCR1E118814

QCCR1E118817

Issue

order to populate the "Group Field
Name" and "Service Field Name" drop-
down lists in the Assignment rule
configuration form.

The User Option condition does not
work correctly when the option value is
an array type.

If you use the task editor to edit a task
in a change model, and then try to save
the change model, you receive a "The
record being updated has been
modified since read" error message.

Inconsistencies can occur between
Change categories and "Open in
Phase'/'Close by Phase" tasks in
change models.

If you tailor the primary key in the
inbox dbdict before you perform an
upgrade, an error occurs during the
upgrade process.

You receive the following error after
you upgrade Service Manager:

Invalid object name 'CM3RM2"

Note: Ignore this error if CM3RM2
is created after the upgrade.

The operators/groups in Approval
Definition are not correct after you
upgrade to Service Manager 9.41.

Several secRights and secRole records
are suffixed by "_migrated" after you
upgrade Service Manager 9.3x (with
Process Designer applied) to Service
Manager 9.41.

Some lines of links are suffixed by "_

HP Service Manager (9.41)

Workaround

In Condition Editor, set the value of User
Option UO1 = {"1"} instead of User Option
uot1="1"

Close the current change model and open
it again to update the changes in the
change model other than the task editor
changes.

Manually update the "Open in Phase" and
"Close by Phase" in Task Planner.

Return the primary key to its original
state.

There is currently no workaround
available.

To workaround this issue, add the correct
operators/groups to the Approval
Definition manually.

Manually remove the "_migrated" suffix
from the profile name.

Manually remove the lines of links that
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Global ID

QCCR1E118821

QCCR1E118823

QCCR1E117439

QCCR1E103336

QCCR1E117328

QCCR1E117598

QCCR1E115349

Issue

disabled_by_PDRM" after you upgrade
Service Manager 9.3x (with Process
Designer applied) to Service Manager
9.41.

Severalrecords are suffixed by "_
disabled_by_PDRM" or "_disabled_by_
PDHD" after you upgrade Service
Manager 9.3x (with Process Designer
applied) to Service Manager 9.41.

Severalrecords are suffixed by "_for_
pd4_tobe_used" after you upgrade
Service Manager 7.11,9.21, or 9.3x to
Service Manager 9.41.

The chm.cm3r.release.mobile form
retrieves members from the
"COORDINATOR" group as the Change
Coordinator values. However, the
current data source table is
"cm3groups,” which is for Service
Manager Classic.

There is no split line between the
Updates tab and the Approval tab in an
Emergency Change record when you
use the Google Chrome browser for
Android.

A Reject Reasonis filed in the
retraction page with an empty Reject
Reason option.

The Array comfill is displayed as a black
block when you use the Mobile
Applications in the self-service user
view.

Items in the "My open Requests" and
"My Closed Requests" lists are not
displayed in the correct order. The
latest request to be created does not
appear at the top.
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Workaround

are suffixed by "_disabled_by_PDRM."

Manually remove the records that have a
"_disabled_by_PDRM" or "_disabled_by_
PDHD" suffix.

There is currently no workaround
available.

Note: Do not delete these records.

Use the "assignment" table instead of the
"cm3groups” table in Service Manager
Codeless.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.
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Global ID

QCCR1E118626

QCCR1E118509

QCCR1E118508

QCCR1E118215

QCCR1E118907

QCCRTE113455

QCCR1E102485

QCCR1E104840

QCCR1E116868

QCCRT1E113689

QCCR1E103975
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Known issues, limitations, and workarounds

Issue

Pictures attached to interactions are
not saved to the local gallery in 10S
8.1.1.

The "not" condition is missing when you
perform hot topic analytics from a list.

When you perform hot topic analytics
from a list, and the condition field is
not in the IDOL index, error messages
are displayed.

The Distributed Image Server does not
support large size images (over TMB) in
concurrent user testing.

Hot Topic Analytics does not support
accessibility as expected.

The remote path and mapping path
cannot be set in the File Server Base
Path if you do not start Service
Manager with administrative
privelages.

You cannot drill down into a pie chart
that uses a simple query.

Only administrators can create a report
on the activity table of each module.
However, if an administrator creates
and shares a report, users who receive
the shared report can subsequently
create reports.

You cannot modify the order of pivot
fields in Hebrew in a dashboard or
preview panel.

You cannot export schedules to the file
server if the schedule name includes a
question mark ("?").

Daylight saving time is not supported
by the tochar() method in adhoc SQL.

HP Service Manager (9.41)

Workaround

Use the Chrome browser instead of
Safari.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

Start Service Manager as an
administrator.

There is currently no workaround
available.

Administrators can share reports with
users who need to create reports.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.
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Global ID

QCCR1E102491

QCCR1E109588

QCCR1E109691

QCCRTE110835

QCCR1E105868

QCCR1E105815

QCCR1E109576

QCCR1E118434

QCCR1E106689

QCCR1E109286

QCCR1E112905

QCCR1E112573

Service Manager 9.41 Patch 5 Release Notes
Known issues, limitations, and workarounds

Issue

The partition color of charts with
simple queries is incorrect.

List reports cannot retrieve data from
replicated databases.

Date/time values are not supported in
multi-level "group by" fields.

Reports that have long legend text do
not print as expected.

Service Manager loads reportsina
dashboard one-by-one.

Service Manager server CPU utilization
is higher than expected when the ToDo
queue is set as the landing page and
the inbox size exceeds 50K.

When you export a report from the
webtier, the report data and definition
are fetched from server. Therefore,
the exported and on-screen reports
may differ if you have modified the
report data but not refreshed the
screen.

The temp file in the Tomcat temp
directory cannot be deleted after the
session is closed.

The list header of a view in the
dashboard and in the ToDo queue are
not the same.

The whole pivot table report is
exported when you de-select some
options in the filter.

The report/Dashboard definition page
is displayed in the old style when you
open it from the favorites and
dashboard area.

Exported charts are inconsistent with

HP Service Manager (9.41)

Workaround

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
available.

Shorten the legend label.

There is currently no workaround
available.

Check the inbox size periodically, and
control the size manually.

Refresh the dashboard before exporting
areport.

There is currently no workaround
available.

Define the list field to match the gbe of
the table.

There is currently no workaround
available.

There is currently no workaround
available.

There is currently no workaround
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Known issues, limitations, and workarounds

Global ID

QCCR1E111387

QCCR1E106640

QCCR1E118269

QCCR1E111234

QCCR1E117603

QCCR1E118983

QCCR1E119106

Issue

the charts in the browser because the
export function and the dashboard use
different rendering methods.

"Title list" type reports are displayed
with all columns in the ToDo queue.

Query conditions in the condition box
and condition builder are not
consistent.

The JVM heap size for the report.export
thread needs to be at least 1024MB
when the export threads are
configured to 10.

You can export reports as a PDF only in
the system language font.

The meaning of the text string "inbox"
is not always clear.

If your SQL Server database uses
Unicode with a collation that does not
support a specific language (for
example, Latin1_General_100_BIN,
which does not support Chinese), when
you create an HTML Template with a
name containing text in that language,
save the template and open the
template again through a search, the
template name is displayed incorrectly
— characters in that language are
displayed as unrecognizable text.

If your SQL Server database uses
Unicode with a collation that does not
support a specific language (for
example, Latin1_General_100_BIN,
which does not support Chinese), when
you create a knowledge document
whose title contains characters in the
unsupported language, the document
is displayed correctly. However, if you

HP Service Manager (9.41)

Workaround

available.

There is currently no workaround
available.

There is currently no workaround
available.

Set a dedicated Service Manager instance
for the reporting schedule.

There is currently no workaround
available.

There is currently no workaround
available.

Click Tailoring > Database Dictionary,
search for "htmltemplates,” click the
htmlcode field, and then change the SQL
RC value to "true."

Click Tailoring > Database Dictionary,
search for
"kmknowledgebaseupdates,”click the
recdata field, and then change the SQL RC
value to "True."

If you already have garbled data in your
search results, perform a full index
against that library.
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Known issues, limitations, and workarounds

Global ID

QCCR1E89819

QCCR1E117326

QCCR1E118616

QCCR1E114145

QCCR1E117903

QCCR1ET13121

Issue

search in the Knowledge Library using
keywords from the document, the
document is returned in the search
results with characters in that
language displayed as unrecognizable
text.

The "Request TCAB Approval" step in
the Normal Change workflow takes
more than 100 seconds to complete
when there are 6000 users in the
database.

The total cost of a Request, Incident,
Problem, Change, or task record is
recalculated when you update the cost
information. Therefore, when you
update an operator’s hourly rate, the
historical cost of the record (that is,
cost that is already incurred) may also
be updated incorrectly.

The Create One Request Fulfillment
Record for each Device of Class X at
location Y effect option in Scheduled
Maintenance does not work correctly.

If two items in a bundle have the same
user option name, only the last user
option can be referenced by the
system for evaluation.

When you cancel a planned purchase
task before you finish creating it,
validation of the task still occurs.

When you order a bundle without a
connector, and when this bundle
contains a sub-bundle with a
connector, the connector that is
defined in sub-bundle does not take
effect.

HP Service Manager (9.41)

Workaround

Modify the "operator" dbdict manually to
fix this issue. First, create a new "a6"
table in the SQL Tables tab. Then, modify
the value of the "secRole" field from "m1"
to "a6" in the Fields tab for both fields
(array field and child field).

There is currently no workaround
available.

There is currently no workaround
available.

Do not use duplicate user options for
items in one service catalog bundle.

There is currently no workaround
available.

There is currently no workaround
available.
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Known issues, limitations, and workarounds

Global ID

QCCR1E119273

Issue

The "Significant" and "KM Change"
change subcategories are not added
during the upgrade process.

Deferred issues

Global ID

QCCR1E105815

QCCR1E105868

QCCR1E100987

QCCR1E111283

QCCR1E118210

QCCR1E118215

Problem Description

Service Manager server CPU utilization is

higher than the benchmark during peak
time if landing page (dashboard) is
enabled.

The Service Manager server should support
more threads loading data simultaneously

in one user session.

In the Mobile client, the user session count

increases until no new users can log in.

Every click on the Problem Hunter button

triggers a search of the IDOL server.

Synchronous API calls to IDOL on Smart
Ticket OCR are not supported.

The Distributed Image Server does not
support large size images (over TMB) in
concurrent users testing.

HP Service Manager (9.41)

Workaround

Manually add the subcategories.

Deferral comment

The potential inbox size was validated
with customers in the early design
review phase. According to feedback
at the time, inbox sizes are not likely
to exceed 50,000 records in the next
two years. The CPU issue occurs only
when the inbox size exceeds the
restricted quantity. When the inbox
size is 100,000 records, the peak time
database CPU% is 44%. When the
inbox size is 50,000 records, the peak
time database CPU% is 16%.

This is a legacy RTE issue; Service
Manager does not support multiple
threads. Changing this requires a
major effort to redesign the whole
implementation.

To work around this issue, add a
Service Manager servlet to increase
the maximum number of sessions.

Deferred as there is limited impact,
according to current performance
testing results.

Deferred as OCR is a back-end task
which will not impact the experience
of end users.

Deferred as over 96% of customers'
attached images are below 500KB.
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Known issues, limitations, and workarounds

Global ID Problem Description Deferral comment

QCCR1ET111026 There is no warning message to access the  This is by design but will be changed in
Restful API Service Doc if the a later release.
restaccessviabrowser parameter is not
enabled.

QCCR1ET113589 The response time when a large number of | There is a popup window to warn end

tasks is mass updated is longer than users that performance may suffer
expected. when they update more than 10
tasks.

QCCR1E127817  Fulfillment Process should be configurable ' Do not use this configuration for the
for Legacy Service Desk workflow legacy Service Desk module. This is
only for streamlined interaction.
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Installation notes

This section provides instructions for installing each component in this patch release:
o Server
« Web tier
« Windows client
« Service Request Catalog (SRC)
o Mobility client
« Knowledge Management Solr search engine
o Smart Analytics

For Service Manager 9.4x components that are not included in this release, you can find the download
links to their latest versions and specific release notes here.

Before you proceed, we recommend that you consult the latest Service Manager 9.41 Support Matrix.
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Backup and backout instructions

In case you need to restore your Service Manager system to its original state after installing the
component patches in this release, make necessary backups before each patch installation. If a rollback
is needed, follow the backout instructions.

Server

Backup

Before you apply the server patch, make a backup of the server installation folder (for example,
C:\Program Files\HP\Service Manager 9.40\Server). If you have used the Windows or Linux
PatchSetup tool to install the current server patch, a backup is already made by the tool.

Note: If you have a horizontally-scaled system, you must back up the server installation folder for
each server instance.

Service Manager has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode, you
must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the
encrypted fields to use the new 32 character encryption you cannot roll back the RTE and still read the
encrypted data.

Backout (Unix)

Follow these steps to back out the installation:
1. Stop the Service Manager server.
2. Remove the existing server installation folder.

3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because the
version of the embedded Tomcat may have dependency on a specific server version.
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Note: If you have a horizontally-scaled system, make sure that every server instance is
replaced with its backup.

4. If you have also loaded platform unload files required for your server changes, you must also roll
back the application changes made by the unload files. See "Applications" on page 41.

5. Restart the Service Manager server.

Backout (Windows and Linux)

Follow these steps to back out the installation:
1. Stop the Service Manager server.

2. Execute the PatchUninstall.bat on Windows or PatchUninstall.sh on Linux (the file is located in the
<SM Installation>\_uninstall directory).

Note: You can only use the server patch uninstallation tool if you have applied the current
patch by using the server patch installation tool. Furthermore, you can only use the tool to
restore a version that was backed up by the server patch installation tool.

If you cannot use the tool to back out your Linux or Windows-based Service Manager server,
follow the steps for Unix-based systems instead.

3. When prompted, enter the full path of the Service Manager server backup directory. A list of the
available backups is displayed.

4. Select the desired backup version and confirm your selection.

Note: If you have a horizontally-scaled system, make sure that every server instance is
replaced with its backup.

5. If you have also loaded platform unload files required for your server changes, you must also roll
back the application changes made by the unload files. See "Applications" on page 41.

6. Restart the Service Manager server.

If the tool fails to back out the server patch, the details are recorded in the PatchUninstall.log file.
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Web tier

Backup

Before you deploy the new web tier, back up the following items:
« lwssofmconf.xml
« web.xmlfile
« application-context.xml
« log4j.properties
o splash screen
o style sheets
o The folder that is defined in the customize-folder parameter in the web.xml file
« <webtier>\images\obj16\ folder

« Any other customizations that you made, including your webtier-<version>.war (webtier-ear-
<version>.ear) file.

Backout

To roll back to the old web tier, follow these steps:
1. Delete or uninstall the existing web tier.

2. Clear the cache of your web application server (for example, Tomcat).

w

. Redeploy the old web tier.

»

Restore your old customizations.
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Windows client

Backup

1. Make a backup of your Windows client home folder. For example,
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored
in this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made
changes to <CLient>\configuration\config.ini file. If so, back up the files from the
location specified in that file.

2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service
Manager > Security). For example, your CA certificates file and client keystore file.

3. Make a backup of the following folder:
<Client>\plugins\com.hp.ov.sm.client.eclipse.user_
X. XX. xxxx\src\resources\icons\obj1l6\.
Backout
1. Uninstall the new Windows client.

2. Reinstall the previous Windows client.

3. Restore your old Windows connections and configurations.

Applications

If you plan to upgrade your applications to this patch level, make a backup of your database before the
upgrade, in case you need to restore your database after the upgrade. Creating a backup of the entire
database and restoring the database if needed is a better approach for a full applications upgrade.

If you plan to load individual unload files in this release, follow the backup and backout instructions
below.
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Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, we recommended that
you use Unload Manager to make a backup of the files to be modified by an unload file, because
Unload Manager can create a backup of your old data during the installation of the unload. If your
application version is not listed above, Unload Manager is not available, and you can use Database
Manager instead.

To use Unload Manager to make a backup, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload to open the wizard.

3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.

4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To use Database Manager to make a backup, follow these steps:

1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to
the unload file.

2. Click List Contents on the menu bar to view a list of files that have been updated in this unload.

See the following figure for an example.
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Process

A["swe.add.cart”, {$L.callnextprocess=true}, {}, {{["se get.recard”, {"name", "file", "text", "stringl"}, {"incident.id in $L.file", "$L.swcCart”, "\"sdIDV™, "\ "svcCart)™}, not nullfincident.id in §

RAD - money.format (100
SCMESSage

A["cs", "10", 20, "Neopravitelna chyba v aplikaci: %5 na panelu %3", "error", {+, '0Z/Z56/12 15:35:24, 4, "ramuro"TF

A['de", "10", 20, "Nicht behebbarer Fehler in der Anwendung: %5 auf Feld 5", "error", {}, '02/28/12 15:33:32", 3, "ramura"TH
4["en", "10", 20, "Unrecoverable error in application: %5 on panel %5", "errar”, {}, '02/28/12 15:33:12', 66, "ramura"T}
{["es", "10", 20, "Error irrecuperable en la aplicacidn: %5 en panel %5", "errar”, {}, '02/28/12 15:33:36", 5, "ramura”]}

A["Fr", "10", 20, "Erreur non récupérable dans 'application @ %45 sur le panneau %5", "error”, {}, '02/258/12 15:33:48", 3, "ramura"]}
A['hu”, 10", 20, "Visszaalithatatlan hiba l&pett Fel az %65 alkalmazasban a %5 panelen”, "error”, {}, '02(28/12 15:33:51", 3, "ramura”]}
A['iE", "10", 20, "Errore irreversibile nellapplicazione: %65 nel riquadro %%:3", "error”, {}, '02/28/12 15:35:08", 3, "ramura"TH

A['iten", "10", 20, "Unrecoverable error in application: %35 on panel 565", "errar”, {}, '02/28]12 15:35:23', 3, "ramuro”];

{['ia", "10", 20, "shgvsisPilsveEsishatTRttEsC\sasTal(spsls %o al2Tkaat sl 11)", "error”, {1, '02/28/12 15:35:34", 3, "ramura"T+

ke, 10, 20, "HECHOEH S8 = 2= 28 ws07h 1 s A 2B SLICE" "errar”, {1, '02i28/12 15:35:44', 3, "ramuro’T+

A['nl", "10", 20, "Unrecaverable error in application: %45 on panel %5", "error”, {}, '02/26/12 15:35:51', 3, "ramura"Tt

{["pl", "10", 20, "\"Mieodwracalny bild w aplikacji: %5, panel %.5.4", "error”, {}, '02J258/12 15:36:01", 3, "ramura"]}

{["pt", "10", 20, "Erro irrecuperdvel no aplicativo: %5 no painel 965", "error’, {}, '02/28/12 15:36:14', 3, "ramura"T}

A['pt-Br", "10", 20, "Unrecoverable error in application: %5 on panel 965", "error”, {}, '02/28/12 15:36:24', 3, "ramura”]}

A['ru”, 10", 20, "Unrecoverable error in application: 365 on panel %5", "errar”, {}, '02/28/12 15:36:35", 3, "ramura"]}

4["zh-Hans", "10", 20, "&53CcCOc078aka3E aoliaaE a0 15k et St UcsiacRan): sesEEaL 1aneR el 2uSET", "arror”, {1, '03/14/13 01:34:16", 5, "Imingyan"]+

ScriptLibrary
-

A["sveCartHelper",
datadict

@fileoverview svcCartHelper - contains functions used by the Service Catalog module when dealing with swcCart and svcCartItems*  @author Alex Corvino™®(*#* This function i

A["activity", {}, "miscellansous”, , , "FALCON", ‘012196 17:00:00", "cblanck”, '06/19/07 00:58:57", , , , , {"cust.visible", "datestamp”, "description”, "negdatestarp”, "number", "operatar”, "syshaom

ackivity
scmessage

A["en”, "1000", 10, "Please specify Area name”, "Fc", I}, '12/01/10 09:33:44', 0, "rolfel"]H

This figure shows the contents of an unload file that contains changes to the following files.

File
Process

application

ScriptLibrary
datadict

dbdict

scmessage

Record
svc.add.cart

money.format

Note: The scmessage records listed under each RAD application are
messages used in this RAD application; no backup is needed for them.

svcCartHelper
activity

activity

Note: The “activity” file with no records actually represents the dbdict record
of the activity file.

The record whose message class is “fc” and message number is 1000.

3. Goto Database Manager, in the Table field enter a file name you got in step 2, and click the Search

button.
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4. If the format selection page shows, select the proper format by double-clicking it (for example,
select the device format for the device file), and then search for the file record.

5. Click More (or the More Actions menu) > Export/Unload after the file record is displayed.

Note: If Export/Unload is not available, check the Administration Mode check box in Database
Manager and try again.

6. Inthe pop-up window, specify your backup upload file path/name, and click Unload Appl.

Caution: Make sure that Append to file is selected.

7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not
available in your application version) to roll back to your old data, as described in the following
instructions.

To roll back to your old data using Unload Manager, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload to open the wizard.

3. Select the unload file generated in the backup process, specify a backup file, and then click Next.
Details of the unload file are displayed.

4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.

b. Click Save to return to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the backup unload.
7. Click Finish.

To roll back to your old data using Database Manager, follow these steps:
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1. Go to Database Manager, click More > Import/Load.
2. Browse to the backup unload file you created.

3. Click Load FG.

SRC

Backup

Before deploying new SRC war package, back up the following files if they have been customized:
o WEB-INF/classes/applicationcontext.properties

« WEB-INF/classes/lwssofmconf.xml

o WEB-INF/classes/cacConfiguration.properties

o WEB-INF/web.xml

o Custom.properties

« secure/configuration folder

Backout

To roll back to the old SRC, follow these steps:
1. Delete or uninstall the existing SRC.
2. Clear the cache of your web application server.
3. Redeploy the old SRC war package.

4. Restore your old customizations.

Solr Search Engine

To back out your Solr search engine changes, make a backup before your KM patch installation.

Note: Keep in mind that you also need to roll back KM-related server side and application side
changes. For details, see the Server and Application backup and backout Instructions.
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Backup

Before installing the KM patch component and upgrading the JDK and KM-embedded Tomcat, perform
the following tasks:

« Make a backup of the search engine installation folder. For example, C: \Program
Files\HP\Service Manager 9.41\Search Engine Backup

o Make a backup of the files to be modified by the unload files in the KM patch.

« Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.

Backout

After installing the KM patch, follow these steps:
1. Stop your Solr search engine.

2. On Windows: at the Windows command line, run the following command to remove the old KM
Search engine windows service:

installasservice.cmd remove [nodetype]

Note: In this command, [nodetypel is a placeholder for "master” or "slave", depending on
whether the KM Search engine server is the master or a slave.

3. Remove the existing search engine installation folder.
4. Copy the backup folder back.
5. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.

6. Be sure to roll back KM related changes on the Service Manager server and application sides,
including the kmsolr unloads files and the server's schemastub file.

7. On Windows: at the Windows command line, run the following command to install the old KM
Search engine windows service:

installasservice.cmd install [nodetype]

Note: In this command, [nodetypel is a placeholder for "master" or "slave", depending on
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whether the KM Search engine server is the master or a slave.

8. Restart your Solr search engine.

9. Perform a full re-indexing on all of your knowledgebases.

Digital signature notice

HP signs Windows executable files with a digital signature. Since January 2012, this process has been
updated to use a new VeriSign root certificate. On a Windows system that does not have the new
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to
Properties > Digital Signatures > Details, the following verification error is displayed:

The certificate in this signature cannot be verified.

Digital Signature Details

General | advanced |

==, Digital Signature Information
: The certificate in the signature cannot be verified.

[~ Signer information
Hafre: [Hewdett-Packard Company
E-mai: Mot avvailable
Sigring time: [Tussday, January 10, 2012 8:13:50 PM
Views Certificate
Counbersignatures
Name of signer: | E-mail addrass: Timestamp
Verisign Time 5t...  Not availabls Tuesday, Janwary 1...

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as
documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=5019140
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Server update installation

The server update for your operating system consists of a compressed file, sm9.41.0020-P5_<0S>.zip
(or .tar), which contains updated files of the HP Service Manager server. These files add to or replace
the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_
unloads directories.

Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (0ClI) 11.2.0.3 or later is
required for Service Manager. For more information, see the latest Service Manager 9.41 Support
Matrix at https://softwaresupport.hp.com/group/softwaresupport/support-matrices

Built-in troubleshooting tool (SM Doctor)

The server patch will install the HP Service Manager Doctor (SM Doctor) tool in the <SM server root>\
(<SMserver root>/)smdoctor directory. For information on how to use this tool, see the Guides and
reference > Troubleshooting > HP Service Manager Doctor section in the Help Center.

Upgrade paths

This server patch must be applied on top of an earlier Service Manager 9.4x system.

The following server upgrade paths are recommended:
o New customers: Install the Service Manager 9.40 GA server, and then apply this server patch.

« Existing SC6.2, Service Manager 7.11/9.21/9.3x customers: Uninstall the old server, install the
Service Manager 9.40 GA server, and then apply this server patch.

« Existing Service Manager 9.4x customers: Apply this server patch.

For installation instructions for the Service Manager 9.40 server, see the Service Manager 9.40
Interactive Installation Guide, which you can download from this site:

https://softwaresupport.hp.com/group/softwaresupport/search-result/-
/facetsearch/document/KM01294561
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JRE upgrade

For Windows and Linux, the server's embedded JRE is automatically upgraded to version 8 after you
apply the server patch; for other Unix-based platforms, you need to manually perform this JRE upgrade.
Before you proceed, pay attention to the following issues.

Preventing failure of external web service calls over SSL

The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint does not
support Server Name Indication (SNI), which is by default activated in JRE 8. Once Service Manager is
upgraded to use JRE 8, it starts to use SNI extensions during the SSL handshake. If the remote endpoint
does not support SNI, the web service call will fail with an error message.

To solve this issue, do either of the following:
« Activate SNI at the remote end point (recommended)

« If the remote endpoint does not support SNI extensions, SNI cannot be activated. In this case, add
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of the
servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=Ffalse (in sm.ini)

sm -JVMOption2:-Djsse.enableSNIExtension=false (in sm.cfg)

Running the server on Linux with JRE 8

If you are using a horizontal implementation on Linux, after you upgrade the server, you may not be able
to kill a locked session from the Show Locks format (system.status.locks.g). This issue occurs only when
JRE 8is used and only on certain Linux versions.

If it occurs, perform the following steps for the hosts file of each server to the solve the issue:

-

. Open the hosts file of your server host (/etc/hosts).
2. Comment out the following line: 127.0.0.1 localhost
That is, change the line to the following: #127.0.0.1 localhost
3. Make sure the hosts file specifies only one host name for your server's IP.

4. Repeat the steps above for the rest of the server hosts.
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Server patch installation steps (Unix)

Caution:

o The server patch will upgrade your embedded Tomcat to version 8.0.32, and therefore requires

additional steps.

« The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.

To install the new sever patch, follow these steps:

-

. Stop all Service Manager clients.

Stop the Service Manager server.

. Make a backup of the Server installation directory. See also "Backup and backout instructions" on

page 38.

Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to a higher version
after the server patch is installed.

Delete the RUN/lib directory.

Extract the compressed files for your operating system into the main Service Manager directory on
the server.

Set the file permissions for all Service Manager files to "755."

For the following Unix servers, manually upgrade to one of the following JRE versions, if you have
not already done so.
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a. Install an appropriate version of JRE for your platform.

HP-  JRE 8 (JRE_8.0.04 or greater)
UX

AIX JRE 8 (SR2FP10)

Caution: To use JRE 8, your AIX version must be one of the following:
o AIX7 7100-03 or later

« AIX6 6100-07 or later

Note: You can check the JRE version on AIX by running the $<JRE INSTALL
DIR>/bin/java -version command,in which <JRE_INSTALL_DIR>is the
JRE installation directory. Make sure that the system output consists of the
following line:

Java(TM) SE Runtime Environment (build pap3280sr2fpl0-20160108
01(SR2 FP19))

Solari = JRE 7 (update 80 or greater)
s

b. Set your JAVA_HOME environment variable to point to the correct JDK (if you have JDK
installed) or JRE (if you have only JRE installed).

c. Execute \RUN\removelLinks.sh to remove the old symbolic links and then execute
\RUN\setupLinks.sh to create new symbolic links.

d. Run the following command to check that the JRE version is correct:
RUN\jre\bin\java —version

9. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.

10. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a full reindex for the knowledgebases is then required).
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11. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.

12. Restart the Service Manager server.
13. Restart the Service Manager clients.
14. Verify the version using either of the following methods:

o From the Windows client, click Help > About Service Manager Server. The server version should
be:

Release9.41.0020 build P5
o From the server's RUN folder, run the sm -version command. The server version should be:
Version: 9.41.0020

Patch Level: P5

Server patch installation steps (Windows and Linux)

Caution:
o The server patch will upgrade your embedded Tomcat to version 8.0.32, and therefore requires
additional steps.

« The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.

To install the new server patch, follow these steps:
1. Stop all Service Manager clients.

2. Stop the Service Manager server.
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10.

Execute the PatchSetup.bat on Windows or PatchSetup.sh on Linux (the file is located in the patch
directory).

When prompted, enter the full path of the current Service Manager server installation directory
and the full path of the Service Manager server backup directory.

If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.

Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a full reindex for the knowledgebases is then required).

Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system.In a
scaling implementation, you can run this command from any one of your servers.

Restart the Service Manager server.
Restart the Service Manager clients.
Verify the version using either of the following methods:

o From the Windows client, click Help > About Service Manager Server. The server version should
be:

Release9.41.0020build P5
o From the server's RUN folder, run the sm -version command. The server version should be:
Version: 9.41.0020

Patch Level: P5

If the tool fails to install the server patch, the details are recorded in the PatchSetup.log file.
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Server application unload installation

Note: All unload files in the server’s platform_unloads directory in this release have been already
merged into Service Manager applications 9.41 . These files are provided just in case you do not
plan to upgrade to applications 9.41 while still want to take advantage of the relevant new features
or fixes. Unload files included in this release are for Service Manager 9.3x applications, because the
server and clients in this release do not support applications versions earlier than 9.3x. For the
specific applications version to which each unload applies, see the "Applicable applications version"
column in the following table.

Unload Files Included in the current patch

This release includes the following unload files.

Applicable

applications
Unload version Description
QCCR1E131250_ | 9.4x Improves the Smart Analytics text recognition when you take a
SM941P3_ photo of a computer screen.

SM940.unl

QCCR1E99207_  9.3x(9.30 or = Enables Service Manager to lazy load global lists. This reduces the
SM940_ later) login time in environments that contain a large number of global
SM930.unl lists.

QCCR1E118520_ 9.3x(9.30 or = Enables the enhanced query hash algorithm for the web client.
SM940P3_ later)
SM930.unl

QCCR1E118520_  9.40 Enables the enhanced query hash algorithm for the web client.
SM940P3_
SM940.unl

QCCR1ET112815_ 9.34 Fixes an issue in which Time Period Management menus are not
SM940_ displayed correctly due to incorrect menu condition settings.
SM934.unl

QCCR1E31324_  9.3x(9.30 or | Fixes the issue that with Syslog audit turned on only a syslog record
SM940_ later) showing login is created and no record for logoff is recorded if the
SM930.unl user does not log out "normally.”
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QCCR1E31941_
SM940_
SM930.unl

QCCR1E52767_
SM940_
SM930.unl

QCCR1E67072_
SM940_
SM930.unl

QCCR1E67610_
SM940_
SM930.unl

QCCR1E67647_
SM940_
SM930.unl

QCCR1E70163_
SM940_
SM930.unl

QCCRT1E71099_
SM940_
SM930.unl

QCCR1E71139_
SM940_
SM930.unl

QCCR1E73452_
SM940_
SM930.unl

QCCR1E76724_
SM940_
SM930.unl

QCCRTE76796_

HP Service Manager (9.41)

Applicable
applications
version

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or

Service Manager 9.41 Patch 5 Release Notes

Description

Enables users to use a pre-configured decimal symbol when they
complete numeric fields.

Fixes the issue that users cannot add data policy definitions on
joined tables.

Enables users to take advantage of the new KMStatusListener
background process.

Enables you to block potentially dangerous attachments from being
submitted to Service Manager through the clients (Windows, web,
or web services).

Updates the exception message that occurs in the request
response when closing an interaction by calling Closelnteraction
from a web service without specifying the localSolution field in the
request.

Fixes the issue that the KMUpdate process terminates abnormally.

Enables a QBE list to display Value Lists instead of the data directly
retrieved from the database when you add a field by using Modify
Columns.

Solves the issue that when Service Manager is configured to use
LDAP as the authentication data source, the user is still forced to
change the password if the user's password has expired in the local
database.

Enables Mandanten restricting queries to be updated correctly

after a profile is edited.

Fixes an issue in which a "Signal 11" error occurs when an IR
regeneration is performed after the unique key of cm3r is deleted.

Provides the ability to turn on debugging dynamically for user
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SM940_
SM930.unl

QCCR1E78794_
SM940_
SM930.unl

QCCR1E99147_
SM940_
SM930.unl

QCCR1E99398_
SM940_
SM930.unl

QCCR1E103456_
SM940_
SM932.unl

QCCR1E106292_
SM940_
SM930.unl

QCCR1E112012_
SM940_
SM931.unl

Applicable
applications
version

later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.32 or
later)

9.3x(9.30 or
later)

9.3x(9.30 or
later)

How to load an unload file

Service Manager 9.41 Patch 5 Release Notes

Description

sessions or schedulers.

Removes incident.assignee when a Web Service call specifies the
assignee as 'NULL' through theService Manager 9.31 Mobility client.

Note: This unload is not needed for the Service Manager 9.32
or later Mobility client.

Fixes an issue in which the first tab of a Notebook is reset to be the
active tab when a new interaction is opened through the "Return to
blank interaction" environment settings.

Enables the inactivity timer function to work correctly when the
Service Manager applications version is lower than the server
version.

Enables the "Any of these words" text search option when you
export records to Excel or to a text file.

Enables caching of the globallist and locallist files.

Solves the issue that PD Framework components (including
Condition Editor , Query Editor , Workflow Editor, and Task Planner)
do not work correctly if an earlier version of the applications is
running on the 9.40 RTE and web tier.

Note: This unload is required if you are running 9.3x
applications on the 9.40 platform.

Tip: If your application version is 9.30 ap3, 9.31, or a later version, we recommend that you use

Unload Manager to load an unload file, because Unload Manager can help you create a backup of

your old data and reconcile conflicts during the installation of the unload. If you are running an

application version that is not one of these, Unload Manager is not available, and you can use

HP Service Manager (9.41)
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Database Manager instead.

For detailed steps, search for the following topic in the online help: Load an unload file.

Web tier installation

The web tier update consists of a compressed file, sm9.41.0020-P5_Web_Tier.zip, which contains the
installation files (the .war, .ear, and .unl files) that are required to install the HP Service Manager web
tier. Installing the new web tier will upgrade your web client to this release level.

For detailed deployment steps, see the Service Manager 9.41 Interactive Installation Guide, which is

available to download here.

Note:

o Service Manager 9.41p1 adds support of JBoss EAP 6.4. For information on how to deploy the
web tier on JBoss, see "Deploying the web tier on JBoss EAP 6.4" on the next page.

o As of Service Manager 9.41p3, if you use WAS 7 for the Application server, you must make sure
that your WAS version is 7.0.0.15 or later, or that you upgrade the WAS-embeded JRE to JRE6
SR9 or later.

New customers

You only need to install the new web tier using the .war or .ear file from the sm9.41.0020-P5_Web_
Tier.zip file in this release.

Existing customers

To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then
install the new web tier. To keep your custom changes, you must back up your customized files and then
merge your customizations into the new deployment.

To install the new web tier, follow these steps:

1. Make the necessary backups. For more information about how to do this, see Web tier backout

instructions.
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2. Delete or uninstall the existing web tier .war (or the .ear) file.
3. Clear the cache of your web application server.

4. Deploy the new webtier-9.41.war file or webtier-ear-9.41.ear file.
Note: It is best practice to deploy with a unique context root. For example, /webtier-9.41.

5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to
ensure that any new parameters are properly merged into the files used in your final deployment.
Do this for application-context.xml as well as any other files you may have customized (such as
style sheets and splash screens).

6. Make any new customizations that are necessary for your deployment.
7. Restart the web application server.
8. Check the version by clicking the HP logo (About HP Service Manager) icon.

The web tier version should be: 9.41.0020-P5.

Deploying the web tier on JBoss EAP 6.4

As of version 9.41p1, the Service Manager web tier adds support for JBoss. Currently, the supported
version is JBoss EAP 6.4.

Note: The following steps are for Windows. The steps for other operating systems are similar.

To deploy the web tier on JBoss EAP 6.4, follow these steps:
1. Download and install Oracle JDK 1.8 from the Oracle web site.
2. Set the JAVA_HOME environment variable to your JDK 1.8 installation directory.
3. Download the binary version of JBoss EAP 6.4 from the JBoss website.

4. Extract the JBoss package to a local directory.

Tip: For more information about JBoss deployment, refer to the %JB0SS_
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HOME%\standalone\deployments\README.txt file.
5. Add the JBOSS_HOME environment variable, and set it to the JBoss installation directory (see step
4).

6. Make the following changes to JBoss.
a. Add the following path entries (which are highlighted in red) to the %JB0SS_
HOME%\modules\system\layers\base\sun\jdk\main\module.xml file :

<dependencies>
<system export="true">
<paths>
<path name="com/sun/org/apache/xalan/internal/xsltc"/>

<path
name="com/sun/org/apache/xalan/internal/xsltc/dom"/>

<path
name="com/sun/org/apache/xalan/internal/xsltc/runtime"/>

<path name="com/sun/org/apache/xerces/internal/dom"/>
<path name="com/sun/org/apache/xerces/internal/jaxp"/>
<path name="com/sun/org/apache/xerces/internal/util"/>
<path name="com/sun/org/apache/xml/internal/dtm"/>

<path name="com/sun/org/apache/xml/internal/dtm/ref"/>

<path
name="com/sun/org/apache/xml/internal/serializer"/>

</paths>
<exports>
<include-set>
<path name="META-INF/services"/>
</include-set>
</exports>
</system>
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</dependencies>

b. Inthe %JBOSS_HOME%\modules\system\layers\base\javax\xml\jaxp-
provider\main\module.xml file, comment out the "xalan" dependency:

<module xmlns="urn:jboss:module:1.1" name="javax.xml.jaxp-provider">
<dependencies>
<!--<module name="org.apache.xalan" services="import"/>-->
<module name="org.apache.xerces" services="import"/>
<module name="org.codehaus.woodstox" services="import"/>
</dependencies>
</module>

c. Inthe %JBOSS_HOME%\modules\system\layers\base\javax\ws\rs\api\main\module.xml file,
comment out the "resteasy” dependency:

<dependencies>

<!--<module name="org.jboss.resteasy.resteasy-jaxrs"
services="export"/>-->

</dependencies>

d. Inthe %JBOSS_HOME%\standalone\configuration\standalone.xml file, comment out the
extension and subsystem reference (according to the specific JBoss launch mode):

<!--<extension module="org.jboss.as.jaxrs"/>-->

<!--<subsystem xmlns="urn:jboss:domain:jaxrs:1.0"/>-->

e. Add the following system property to the %JBOSS_
HOME%/standalone/configuration/standalone.xml file:
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10.

11.

12.

13.

14.

<system-properties> <property
name="org.apache.tomcat.util.http.Parameters.MAX_COUNT" value="5000"/>

</system-properties>

Note: <system-properties>...</system-properties> must be located between
</extensions> and <management>.

Extract the webtier-9.41.war file to a folder. For example, a folder named webtier-9.41.
Rename the webtier-9.41 folder to webtier-9.41.war.

Make necessary changes to the web.xml located in the webtier-9.41.war/WEB-INF/ directory.
Copy the webtier-9.41.war folder to %JBOSS_HOME%\standalone\deployments\ folder.

Open your operating system command prompt, and execute the following command to create a
deployment marker file:

echo>> %JBOSS_HOME%\standalone\deployments\webtier-9.41.war.dodeploy

The filesystem deployment scanner in JBoss EAP 6 relies on this marker file, which serves as a sort
of command, to deploy or redeploy the web tier content.

Start JBOSS manually from the %JBOSS_HOME%\bin directory by clicking the standalone.bat file.

Wait until webtier-9.41.war.dodeploy in the %JBOSS_HOME%\standalone\deployments\ directory
is changed to webtier-9.41.war.deployed.

Launch the web client URL to test the connection.

For example, test with this URL: http://localhost:8080/webtier-9.41

Note: The JBoss communications ports are defined in the %JB0OSS_
HOME%\standalone\configuration\standalone.xml file. The default HTTP port is 8080.

Configuration notes for the user experience improvements
in the web client

Sidebar mode
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The sidebar mode only works in Power User view (index.do) and Employee Self-Service view (ess.do), but
does not work in Accessible view (accessible.do) and Self-Service Accessible view (accessible_ess.do).

Accordion mode

When you deploy the Service Manager 9.4x web client together with a version of the Service Manager
applications that is earlier than 9.40, you need to perform the following actions:

o You must install the QCCRT1E114612_SM940_SM930.unl file. Otherwise, the System Navigator does
not work.

o Werecommend that you set the Enablesidebarmenu parameter to "False" to disable the icons and
the sidebar mode of the System Navigator. Otherwise, the Service Manager web client uses the
default icon for all menu items.

Quick help

Service Manager 9.40 or later moves the keyboard shortcut configurations from the web.xml file to the
shortcut.xml file, which is located in the web tier's WEB-INF folder.

If you have customized keyboard shortcuts in a previous version of Service Manager and you upgrade to
Service Manager 9.40 or later, you must move the keyboard shortcut configurations from your old
web.xml file into the shortcut.xml file. Otherwise, your customized keyboard shortcuts do not work. For
more information about how to configure the shortcut.xmlfile, refer to the following online help topic:

System Administration > Tailoring > Web tier > Editing Web client Key bindings

If the configuration of the shortcut.xml file is incorrect, the shortcut list displays an error message.

Web tier application unload installation

The web tier package in this release includes the following unload files.

Applicable

applications
Unload version Description
QCCR1E104944_ 9.41 Enables a fix that hides the User Selections of Service Catalog
SM941P4_ items if their Visible Condition is set to false.
SM941.unl
QCCR1E125775_  9.41 Enables IT users to manually trigger context-aware search.
SM941P4_ Additionally, enables context-aware search to be enabled from ESS.
SM941.unl
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QCCR1E116757_
SM941_
SM940.unl

QCCR1E124742_
SM941_
SM930.unl

QCCR1E129332_
SM941_
SM940.unl

QCCR1E129149_
SM941P2_
SM941.unl

QCCR1E112070_
SM940_
SM930.unl

QCCR1E19946_
SM940_
SM930.unl

QCCR1E103581_
SM940_
SM932.unl

QCCR1E114612_
SM940_
SM930.unl
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Applicable
applications
version

9.40

9.3x(9.30 or
later)

9.40

9.41

9.3x(9.30 or
later)

9.3x(9.30 or
later)

9.3x(9.32 or
later)

9.3x(9.30 or
later)

Service Manager 9.41 Patch 5 Release Notes

Description

Enables look up function support for the security manual list type
setting.

Merges the module configuration requests that are sent from the
web client to the server during the login process. This helps to
reduce the login time.

Enables you to enter values in fields that are made from a global
list when you use the 9.41 web client together with the 9.40 RTE
and applications.

Enables To-Do Alerts to be automatically acknowledged without the
user having to click the Acknowledge button.

For Service Catalog User Selection multi-selection support.

Enables extra columns in the "Attachments" section of records.

Adds support for the auto-complete feature in the web client.

Note: After loading this unload file, you still need to perform
the following tasks to enable auto-complete for a specific
Comfill field in a form:

1. Make sure that the comfillAutoComplete parameter is set
to true in the web tier configuration file (web.xml). The
default value is true.

2. Make sure the Auto Complete property of this field is
enabled in Forms Designer. By default, this property is
disabled.

The following SM9.40 features are using enhanced Remote

JavaScript Service: Service Manager Calendar, Service Manager
Reports, and PD Framework components (including Condition Editor
, Query Editor , Workflow Editor and Task Planner). When running
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Applicable
applications
Unload version Description

SM9.3x applications, the Remote JavaScript Service must be
upgraded by loading this unload file so that these features can
work correctly.

Note: This unload is required if you are running 9.3x
applications on the 9.40 platform.

Windows client installation

Note: No features are being added to the Service Manager Windows (Eclipse) client. We
recommend that Service Manager administrators deploy one of the other three clients (web client,
SRC client, or Mobility client) to end users. You still need the Windows client to perform
administrative tasks.

The Windows client update consists of a compressed file, sm9.41.0020-P5_Windows_Client.zip, which
contains the executable installation files of the new Windows client. Installing the new Windows client
will upgrade your Windows client to this patch level. This version of the Windows client comes with an
updated version of JRE 8.

For installation instructions, see the Service Manager9.41 Interactive Installation Guide, which is available

to download from here.

Note: The Windows client installer will also install the Client Configuration Utility in the <Service
Manager installation path>\Client\ClientConfiguration directory. To run the utility, double-click the
confutil.bat file in this directory. However, we recommend that you use the web client if you want to
provide end users with a customized client.

New customers

You only need to install the new Windows client.
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Existing customers

You need to back up and uninstall the old Windows client, and then install the new Windows client.

To install the new Windows client, follow these steps:
1. Stop the Service Manager Windows client.
2. Make necessary backups. For details, see Windows client backout instructions.

3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)

4. Run setupclient.exe to install the new client.
5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.41.0020-P5.

Applications Update installation

This release does not contain an applications or upgrade package. The latest applications version is
9.41. An applications upgrade is optional, and you can install the Service Manager 9.41 Applications or
Upgrade package according to your current applications version.

You can find the SM 9.41 Applications or Upgrade package as well as HP Service Manager 9.41 Release
Notes in the Service Manager 9.41 installation media.

Service Request Catalog (SRC) installation

Service Manager 9.41p5 includes the SRC package (src9.41p5.0013. zip), which contains:
o The SRC deployment file (src-9.41p5.war)

o Unload files for SRC 9.41.p5 and for previous versions

Unload file naming convention

The unload files use the following naming convention: <CR_ID>_SRCxxxPxx_SMxxx.unl, where:
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o <CR_ID>: The identification number of the applications defect that the unload file fixes. For example,
QCCR1E12345.

e SRCxxxPxx: The minimum SRC patch level that requires the unload file. For example, SRC940p1,
which means the unload file comes with the SRC9.40 patch 1 and should be used for patch 1 or
higher.

o SMxxx: The Service Manager applications version that requires the unload file. For example, SM941,
which means the unload file is intended only for Service Manager applications version 9.41.

Note: In this release, the English version of the online help is updated for Service Request Catalog
9.41, while the localized versions are still based on SRC 9.32.

Before you proceed, read the Service Request Catalog 9.41 Interactive Installation Guide and the Service
Request Catalog 9.41 Customization Guide, which are available to download from here.

Note: Users who want to use Service Request Catalog on their tablet devices can download the
HP Service Request Catalog app to their device from Google Play or the Apple App Store. To locate
these apps, search for "HP SRC" in the appropriate store.

The HP Service Request Catalog 9.41 tablet app supports Service Request Catalog versions 9.33
through 9.41p5.

New customers

1. Deploy the src-9.41p5.war file by following the instructions in the Service Request Catalog 9.41
Interactive Installation Guide.

2. Configure SRC 9.41p5 by following the instructions in the Service Request Catalog 9.41
Customization Guide.

Existing customers
1. Install SRC 9.41p5, as described above.

2. Migrate your customizations from the old deployment to SRC 9.41p5.

SRC application unload installation

This SRC package in this release includes the following unload files.
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Unload file

QCCR1E136291_
SRC941P5_
SM941.unl

QCCR1M2359_
SRC941P3_
SM941.unl

QCCR1E129134_
SRC941P3_
SM941.unl

QCCR1E126562_
SRC941P2_
SM941.unl

Introduced
in which
patch

SRC 9.41p5

SRC 9.41p3

SRC9.41p3

SRC9.41
p2

Used for

apps
version(s)

SM 9.41

SM 9.41

SM 9.41

SM 9.41

Description

Prevents surveys from being able to create
interactions for inactive categories (such as
"complaint” or "compliment").

Enables you to cancel support requests directly from
the SRC UL

Enables "request for" and "callback contact"” users to
update or cancel Support Requests directly from the
SRC UL

Enables SRC to support both Process Designer-based
requests and non-Process Designer-based quotes
simultaneously.

Mobility client installation

Service Manager 9.41p5 includes a compressed file (sm9.41.5000-P5_Mobility.zip), which contains the

following files:

« Mobility client installation file (webapp-9.41.5000.war)

« Mobility client self-service interface unload (MOBILITY_ESS_SM941_SM932.unl)

« Unload to fix the issue in QCCRT1E123225 (QCCR1E123225_SM941P1_SM932.unl)

« Unload to fix the issue in QCCR1E125623 (QCCR1E125623_SM941P1_SM930.unl)

New customers can directly install the new Mobility client by deploying the webapp-9.41.5000.war file,

while existing customers must uninstall their old Mobility client and then install the new one.

The Mobile ESS module is included in the Service Manager 9.40 or later applications, but not in earlier

versions of the Service Manager applications that are supported by the Service Manager 9.4x platform

(that is, Service Manager 9.34, 9.33, or 9.32). The .unl file is provided for customers running an older

version of the Service Manager applications who want to use the Mobile ESS module.
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Installation steps

Note: The Service Manager 9.41p5 Mobility client supports Apache Tomcat 7.0 and 8.0 web
application servers. Additionally, it can only work with Service Manager server 9.40 or later and
applications 9.32 or later.

For more information about how to install the Service Manager 9.41p5 Mobility client, refer to the
Service Manager 9.41 Mobile Applications User Guide, which you can access from here.
Enabling the Mobility self-service interface when running applications 9.32, 9.33, or 9.34

The Service Manager 9.41p5 Mobility client comes with a self-service user interface. However, if you are
running the 9.32, 9.33, or 9.34 applications, you must load the MOBILITY_ESS_SM941_SM932.unl file to
enable this interface. For instructions on how to load an unload file, see "Server application unload
installation” on page 54.

Knowledge Management (KM) Search Engine and
Import Utility installation

IDOL Search Engine

Service Manager 9.41 Smart Analytics includes a Smart Search feature based on the IDOL Search
Engine. If you want to use the IDOL Search Engine for Knowledge Management, you do not need to
install or upgrade the Solr Search Engine.

For more information on how to install and configure the IDOL Search Engine, see the HP Service
Manager 9.41 Smart Analytics Administrator and User Guide.

Solr Search Engine

This release includes a package for the Solr Search Engine and Import Utility:

o \kmsolr_unloads\QCCR1E91035_SM940_SM930.unl: This unload file contains all Solr Search Engine
related application fixes that were released after Service Manager 9.30. These fixes are already
merged into the Service Manager 9.40 or later applications. However, if your applications version is
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9.3x, you must load this unload file after you install the Solr Search Engine.

o \kmsolr_unloads\QCCR1E128475_SM941P3_SM940.unl: This unload is used to enable HTTPS
connections for the Solr Search Engine. Loading this unload will add a new option, SSL Enabled, in the
Knowledge Management Environment record (Knowledge Management > Administration >
Environment). See also the following HPE white paper:

Configuring FIPS Mode in Service Manager
« knowledgemanagement folder: Contains updated files of the Solr Search Engine

o km-import-9.41.zip: The installation files of KM Import Utility version 9.41.

New customers
1. Make sure that you have already installed Service Manager 9.41 server and clients.

2. Install the Service Manager 9.40 Solr Search Engine . For installation instructions, see the Service
Manager 9.40 Knowledge Management Search Engine Guide.

3. Update the JDK installed on your search engine server host to JDK 8, if you have not already done
so.

4. On Windows: at the Windows command line, run the following command to remove the old KM
Search engine windows service from the Solr search engine installation directory (if the service is
installed):

installasservice.cmd remove [nodetype]

Note: In this command, [nodetype] is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.

5. Remove the Tomcat folder in your Solr Search Engine installation folder.

6. Extract the files in the knowledgemanagement folder in the 9.41 km patch .zip file to your Solr
Search Engine installation directory to overwrite your existing files.

7. At the Windows command line, run the following command to install the new KM Search engine
windows service from the Solr search engine installation directory:

installasservice.cmd install [nodetypel
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10.

Note: In this command, [nodetypel is a placeholder for "master” or "slave", depending on
whether the KM Search engine server is the master or a slave.

Change the HTTP port and shutdown port that is defined in the <Solr installation
directory>/tomcat/conf/server.xml file, according to your requirements.

Start your Solr Search Engine.

Configure your search servers and knowledgebases, and perform a full indexing for all of your
knowledgebases. For details, see the Service Manager 9.41 Solr Search Engine Guide.

Existing customers

Existing customers must install the Service Manager 9.40 Solr Search Engine first, and then apply the

Service Manager 9.41 Solr Search Engine patch.

. Make sure that your Service Manager server and clients have upgraded to version 9.41.

Stop your Solr Search Engine.
Make a backup of your Solr Search Engine installation folder and other necessary backups.

Update the JDK installed on your search engine server host to JDK 8, if you have not already done
so.

On Windows: at the Windows command line, run the following command to remove the old KM
Search engine windows service from the Solr search engine installation directory:

installasservice.cmd remove [nodetype]

Note: In this command, [nodetypel is a placeholder for "master" or "slave", depending on
whether the KM Search engine server is the master or a slave.

Remove the Tomcat folder in your Solr Search Engine installation folder.

Extract the files in the knowledgemanagement folder in the 9.41 km patch .zip file to your Solr
Search Engine installation directory to overwrite your existing files.

At the Windows command line, run the following command to install the new KM Search engine
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10.

11.

12.

13.

14.

15.

windows service from the Solr search engine installation directory:

installasservice.cmd install [nodetypel

Note: In this command, [nodetypel is a placeholder for "master” or "slave", depending on
whether the KM Search engine server is the master or a slave.

Change the HTTP port and shutdown port that is defined in the <Solr installation
directory>/tomcat/conf/server.xml file, according to your requirements.

If you are running a 9.3x version of the Service Manager applications, load QCCR1E91035_SM940_
SM930.unlinto your Service Manager system.

Caution: Skip this step if you are running the Service Manager 9.4x applications.

If your sm.ini file already contains the following line, remove it.

KMSearchEngineClass:com.hp.ov.sm.server.plugins.knowledgemanagement.solr.KMSolr
Search

Note:

o Skip this step if you are running Service Manager 9.3x applications, or if you are running the
Service Manager 9.40 (or earlier) RTE.

o This parameter is no longer needed for the Service Manager 9.41 RTE. If it is present in the
sm.ini file, a warning message will occur in the Service Manager server log (sm.log).

Remove the KMCores folder in your existing search engine web application folder (for example,
C:\Program Files (x86)\HP\Service Manager9.40\Search_Engine\tomcat\webapps).

Restart your Solr search engine.
Restart the Service Manager service.

Perform a full re-index of all of your knowledgebases. For details, see the Service Manager 9.41 Solr
Search Engine Guide.
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KM Import Utility installation

Note: The km-import-9.41.zip file included in this release is same as the one shipped with previous
releases.

To install this utility, extract km-import-9.41.zip in the Knowledge Management package to a local

drive. For detailed instructions on the use of the import utility, see the README file packaged in this .zip
file.

KM server admin console

As of Service Manager 9.41P4, the KM server admin console is removed.
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Additional information

Additional information

o Service Manager 9.41 Installation and Upgrade Documentation Center (for detailed instructions on
how to install Service Manager, including all backup and backout procedures)

« Service Manager Support Matrices

« As always, we encourage you to actively participate in making Service Manager better. Please follow
us on Twitter at @HPITSM, join our LinkedIn group "HP ITSM," or join the discussion on our blog.
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Send Documentation Feedback

If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:

Feedback on Service Manager 9.41 Patch 5 Release Notes (Service Manager 9.41)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to ovdoc-ITSM@hpe.com.

We appreciate your feedback!
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